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Summary 
This report describes further work and training related to the ISSMI Integrated Stock Survey and Management 
Inventory technique for conservation and management of natural forest in Uganda.  It also discusses progress on 
tree volume sampling, permanent sample plot work, and exploratory inventory. 
 
During this assignment, the ISSMI software has been strengthened in a number of ways.  It has been split into an 
application program and separate database, improving network performance and facilitating future upgrades.  
The GIS linkages have been fully developed, including geo-referencing of blocks and trees, and output of a block 
polygon file and tree attribute table.  Tree selection for harvesting and protection has been simplified and im-
proved to take into account spatial patterns.  A new report has been added for polyblock summaries.  The Excel 
block mapping program has been improved to show selected trees with colours and symbols, and to list statis-
tics.  A standardised 3-letter species mnemonic has been added to the species list that is used in the Excel mapper 
and exported to the GIS tree attribute table.  The quick mapper used for spatial data checking has been reconfig-
ured to avoid earlier installation problems.  More extensive training in ISSMI was given than hitherto, and two 
project professional staff are now fully acquainted with ISSMI and with the GIS linkages.   
 
Two keynote presentations were given at a workshop held at Masindi from 6-7th December 2000 which covered 
yield regulation concepts in natural forestry, and the ISSMI system.  This workshop served to establish ISSMI as 
a formal technique for natural forest management in Uganda.  The consultant also led a field training exercise in 
ISSMI at the workshop. 
 
Progress in tree volume sampling was reviewed and found to be minimal.  It is clear that the existing volume 
equations based on Relascope sampling are inaccurate and urgently need to be replaced.  A high priority should 
be given to tree volume sampling over the next two to three months to get this work underway.  PSP work was 
likewise reviewed;  it was found that the EPHRU software developed earlier by the consultant was being used to 
enter data, but only 10 plots were in the system.  Generally the data processing section (TSS, or Technical Services 
Section) appears to be under-resourced in terms of personnel, space and equipment; the problem is exacerbated 
by deficiencies in work control methods.  The consultant suggests that this needs to be reviewed and addressed 
with some urgency. 
 
The exploratory inventory methods were discussed, a field form designed, and an Excel program prepared 
which produces random transects in a format that can be imported into the GIS system for mapping.   However, 
no EI database development was possible within the current assignment, and this will be a priority requirement 
if the EI data is to be entered and analysed. 
 
 
 

                                                      
1 E-mail: denis@bio-met.co.uk 



Introduction 

Background 
The assignment described in this report continues work under the EC Forest Conservation 
and Management Project (FCMP) to improve some aspects of quantitative forest manage-
ment in the natural tropical forests of Uganda.  The earlier visits have been concerned with 
the development of an integrated stock survey and inventory technique known as ISSMI, the 
improvement of tree volume equations, permanent sample plot work in the natural forests, 
and exploratory inventory techniques.  The main contribution by the consultant in these ar-
eas has been in suggesting suitable and efficient techniques, designing field forms, develop-
ing appropriate software, and staff training relative to both the field aspects and data proc-
essing.  These technical issues have also been linked to the central objective of improved sus-
tainability of forest management through proper planning, monitoring and control. 

Terms of Reference 
For the present visit of about 25 working days, the terms of reference (TORs) covered the 
following aspects: 

� Improvements and modifications to the ISSMI software, development of linkages with 
the GIS system, training in ISSMI, and review of progress; 

� Review of progress with PSP and tree volume studies; 

� Participation in a workshop on ISSMI held in Masindi from  6-7 December; 

� Software development and design work for Exploratory Inventory (EI). 
 
These TORs have been substantially completed, as will be detailed in the report.  In particu-
lar, ISSMI has been greatly improved as a software package and in its tree selection method 
for forest management.  Much more training than hitherto has been given, focussing espe-
cially on the GIS linkages with ISSMI, but also covering all aspects of the package.  There are 
now two key staff trained in ISSMI, rather than one as formerly.  The Masindi workshop has 
established ISSMI nationally as the primary technique for natural forest management. 
 
The progress on PSPs and volume studies has been reviewed and will be detailed in the re-
port, but can basically be summarised as slight.  As will be discussed, data processing activi-
ties are under-resourced and under-managed, and this is an area which will need to be ad-
dressed in future. 
 
Time did not permit as much work on the exploratory inventory as originally hoped.  At 
least two further weeks are required for software development, and there should preferably 
also be time allocated for field supervision and training in inventory planning and analysis, 
as well as for actual analysis of a preliminary data set both to check the software and as part 
of the training process.  However, the consultant was able to confirm design concepts, and 
prepare a GIS-compatible program to generate random inventory transects, as well as to de-
sign the field form to be used.  
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ISSMI 

The ISSMI concept 
ISSMI is an acronym for Integrated Stock Survey and Management Inventory.  It can be seen 
as having three layers: 

� A field procedure for stock survey and management inventory, 

� A data processing package which translates the field results into stock maps and inven-
tory tables, 

� A sustainable forest management system, based on the detailed information, monitoring 
and control capability of the field and data processing aspects. 

 
During the present visit, the consultant has made a number of improvements to the ISSMI 
computer package, which are described in the following sections, to improve performance 
and ease of use, and provide some additional tables and linkages to the Forestry Depart-
ment’s GIS system.  The field procedures have remained unchanged, and now can be re-
garded as a stable and well established operation.  The management layer is the area which 
now requires to be developed further, through application of the system. 

Field procedures 
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Figure 1  Lines are cut at 200 m intervals East-West and North-South 

The ISSMI field procedures are now well-
established and have not been modified as a 
result of this consultancy visit.  They are de-
scribed here briefly for reference purposes. 
 
ISSMI combines stock survey and manage-
ment inventory into a single operation.  The 
operation is usually carried out at compart-
ment level, on areas of around 500-600 ha, 
and should be done about a year before har-
vesting. 
 
A base line is established in a NS orientation 
at a convenient access point (see Figure 1).  It 
may be located relative to a pre-planned grid 
using a GPS.  From this primary base line, an 
initial strip line is cut in an EW direction. 
 
Further NS block lines are then cut at 200 m 
intervals from the first strip line.   Additional strip lines are cut every 200 m along the NS 
baseline.  This subdivides the forest into a series of 200 x 200 m blocks. 
 
Once this demarcation has been done over a sufficient area, a team then cuts guide lines at 
40 m intervals in a NS direction in each block (see Figure 2).  These guide lines divide the 
block into 5 NS sweeps. 
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Stock survey is carried out usually 
be two teams each with blue paint, 
a diameter tape, and a skilled tree 
spotter.  They move up each 
sweep with a single booker, who 
stays in the guide line to the west 
of the sweep.  For each tree over 
the specified minimum diameter, 
the position north from the block’s 
southernmost boundary is re-
corded (0 to 199 m), and the dis-
tance east within the sweep is es-
timated (0-39 m).  These, together 
with the sweep number, record 
the tree’s position within the 
block.  Each stock tree has a num-
ber painted on its buttress or bole, 
as close to the ground as possible 
so that it will remain visible if the 
tree is felled.  The number is 
painted on the due north side of 
the tree if buttressing permits, or 
as near thereto as possible.  The 

trees within a block are numbered sequentially. 
 
The sweeps are surveyed in a zig-zag fashion (Figure 2), moving north on the first sweep, 
turning and going south on the second, and so on.  The sequence of stock numbers follows 
this pattern. 
 
On the first and last guidelines, at 40 and 160 m, a temporary sample plot is established.  
This is a circular plot of 12.62 m radius (500 
m2) on which all trees down to 20 cm are 
measured.  On the NE quadrant of this plot, 
trees down to 10 cm are measured (see Fig-
ure 3). 
 
For the stock survey, the standard proce-
dure prescribes that all trees down to 50 cm 
are recorded.  This has been varied to record 
Funtumia elastica down to 40 cm, as it is 
normally only common as a smaller tree. 
 
The data recorded for each species comprise 
species identification, diameter at breast 
height or above buttress, a stem quality code 
ranging from 5 for a perfect bole to 1 for a 
tree with no possible timber use – severely 
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Figure 3  Layout of circular sample plot 
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Figure 2  Layout of lines and plots within 200 x 200 m blocks 
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misshapen, rotten or otherwise unusable.  A series of coded notes are provided to record 
observations about the tree – broken top, decay, damage, climbers, deformation, and so on.  
The same system of measurement is used for stock trees and smaller trees measured on the 
TSPs. 
 
The trees over 50 cm (or 40 cm for Funtumia elastica) are measured on 100% of the forest area.  
Trees from 20 to 49 cm are measured on 5% of the area by a systematic sample.  Pole sized 
trees, from 10-19 cm, are sampled on 1.25% of the area. 

Data processing 
A software application had been de-
veloped using Microsoft Access 97 dur-
ing earlier consultancy work related to 
ISSMI.  This provides for entry of stock 
survey and sample plot data, and some 
reporting and mapping facilities.  In 
addition, a program in Microsoft Excel 
97 was written for drawing tree maps 
of single blocks which has proved to be 
very useful for control and monitoring 
on the ground. 
 
During the present visit a number of 
improvements have been made to the 
software, which are described in detail in the following sections.  ISSMI now includes the 
software shown in Figure 4.  The main ISSMI application is an MS Access program.  This has 
been split from the database, which is also an Access file, but contains only the data tables 
for block headers, plot headers, stock trees, plot trees, the species list, and some related ta-
bles.  The ISSMI application has various reports and tables, which are unchanged from pre-
vious versions, and an additional management report which is described further in the rele-
vant section below. 

Figure 4  Components of the ISSMI data processing system 
 

Data entryData entry
ISSMI

Application
(Access)

ISSMI
Application

(Access)

ISSMI
database
(Access)

ISSMI
database
(Access)

ArcView GIS
High quality maps
ArcView GIS

High quality maps

Excel mapper
Block maps for 

monitoring & control

Excel mapper
Block maps for 

monitoring & control

Quick mapper
Data checking, 

forest management

Quick mapper
Data checking, 

forest management
Stand tables, 
tree lists, etc.

Stand tables, 
tree lists, etc.

 
The Quick Mapper, written in MS Visual Basic, has been causing problems due to installa-
tion difficulties.  It has now been revised and works properly.  The Excel mapper has been 
one of the more successful parts of the system.  It has been slightly modified in this version 
to provide greater ease of use. 

Re-organisation of processing programs and database 
Originally, ISSMI was a single Access file that contained both the database and the various 
forms, reports and programs that form part of the system.  This involves difficulties when 
any part of the program is updated, since all the data must be carefully synchronised be-
tween the current version of the database and the updated version before an upgrade can be 
released for service. 
 
Microsoft recommend splitting applications of this type into two parts, called in their jargon 
a front-end (FE) application and back-end (BE) database.  This works faster and more effi-
ciently on a network and is also easy to update, since the database does not need to be 
touched when a new version of the application is released.    This has now been done with 
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ISSMI and thoroughly tested under network conditions, with multiple access to the same 
form or data table simultaneously.  The new version performs well and has already saved 
much time in terms of ease of maintenance and support. 
 
It has also been found as part of this process that different versions of MS Access can be 
used without difficulty, provided some basic rules are respected.  The BE database on the 
file server must be kept in the earlier version, Access 97, without using the ‘convert data-
base’ option.  The FE applications can, if they are running on a machine that uses Access 
2000, be converted using the automatic Wizard that pops up as soon as an Access 97 file is 
opened.  The mixed application will run without difficulty. 
 
However, the master database should not be converted to Access 2000 as it will otherwise 
become inaccessible to all users who only have Access 97.  Once Access 97 is no longer in 
use, then the conversion can be carried out.  If the file is inadvertently converted, then it can 
be saved again in Access 97 format under an option on the Access 2000 menu. 

Upgrades to the quick mapping program 
The ISSMI mapping application, which is a separate Microsoft Visual Basic program has been 
changed from an OLE1 server to a stand-alone EXE application called from the ISSMI menu.  
There are installation problems with OLE servers which had inhibited the use of this facility.  
The amended system avoids these problems and is simple to install.  The mapper has been 
revised, and recompiled using version 6 of MS Visual Basic, which also has improved ro-
bustness and ease of use compared to the earlier VB4 version. 
 
The functions of the quick mapping program have not been changed, but they are now set 
from a menu, whose facilities are described in the table below. 
 
Menu Description 
File► Database Opens a dialog box to search for the ISSMI database.  When started from ISSMI, this is not 

needed, as the database name is passed automatically. 
 Location Produces a list of compartments in the database as a popup menu.  Selecting one will result in it 

being mapped. 
 Refresh When the mapper is used in tandem with ISSMI, corrections can be made on the data, such as 

block or plot coordinate changes.  The effect of these will not be seen on the maps until the ‘re-
fresh’ function is run. 

Map► Zoom Zooms in on selected blocks.   If no blocks are selected, draws the whole compartment. 
 Full Draws the whole compartment. 

Species 
groups 

Trees are coloured according to the group colours selected in the ISSMI species groups form.  In 
addition tree symbols show cirles with an X through for harvest trees, or solid circles for seed trees.  
Reserve trees are empty circles. 

 Colours► 

Tree Se-
lection 

Trees are coloured according to selection: Blue for harvest trees, red for seed trees, and green for 
reserve or unselected trees. 

 Stock No. If checked, stock numbers will be shown against each tree when the map is zoomed. 
 Inv. Plots If checked, inventory plot locations are drawn as yellow circles. 
 Copy Copies the current map image to the clipboard.  From there it may be pasted into another applica-

tion such as Word, Paintbrush or Powerpoint.  Images are copied as bitmaps (.BMP). 
 

                                                      
1 OLE: Object linking and embedding.  Such programs are contained in .DLL library files and require to be properly registered 
in the Windows Registry.  The registration process was found to be non-automatic and involve several obscure steps, making it 
difficult to use the mapper when ISSMI was moved to a new machine or directory. 
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The main uses of the mapper are to view tree selection and species distribution, and to check 
on plot and block co-ordinates.  If the latter are not correct, then the plot or block will appear 
displaced.   The images produced by the mapper are of low resolution, and are suitable 
mainly for  inclusion in word-processor reports and for on-screen presentations.  For high-
resolution maps, together with overlays of compartment boundaries, roads, rivers, etc., the 
data must be exported to the ArcView GIS system. 

Geo-referencing and GIS linkages 
The database has been modified to add extra fields to the Blocks table called [UTM North] 
and [UTM East].  These store the UTM co-ordinates for each block.  A form has been created 
which allows the user to enter UTM co-ordinates from GPS readings taken at the SW corner 
of selected blocks, as shown in 
Figure 5.  On this form, the UTM 
co-ordinates for a compartment 
will be initially blank.  A single 
GPS reading is entered for any 
block, and the Update button 
clicked.  The UTM co-ordinates  
for the rest of the compartment 
will then be filled in, based on 
their local co-ordinates relative to 
the block where the reading was 
taken. 
 
This procedure is imperfect, as 
some survey errors and deviations 
will always occur in the real 
world.  A better method would be to take 4-8 GPS readings at widely spaced locations over 
the compartment, and apply a scaled transformation to get best approximations for other 
points, based on the distortions between the theoretical and actual locations of the control 
points.  However, the consultant had neither the time nor the necessary reference books to 
design an algorithm based on the latter method.  For the moment, the method is adequate 
provided survey standards are high. 

Figure 5  form for adding and updating georeferences to blocks in ISSMI 

 

 
Once a compartment has been geo-
referenced, then the GIS output files 
can be generated, using the form 
shown in Figure 6.  The compart-
ment is selected, and when the OK 
button is clicked, two files are gen-
erated.  These are given default 
names with extensions .LIN and 
.TXT respectively.  These default 
names and output directory can be 
amended by the user before creat-
ing the output files. 

Figure 6  GIS output form in ISSMI 
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The .LIN file contains the line information in a format that can be processed in ArcInfo using 
the GENERATE, CLEAN and BUILD commands.  The former will import the file and create an 
ArcInfo coverage.  The latter builds the block line information into polygon topology, which 
is more useful than simple lines in the GIS system.   The coverage, once created, can be 
added to an ArcView map. 
 
The .TXT file is a table of tree data in text format, in which each tree has its individual UTM 
co-ordinates.  This file can be imported directly into ArcView and overlaid on compartment 
boundary and other information as a high quality stock map.  The various fields in the file 
can be used within ArcView to label, colour or size points or  to select distinctive symbols.  
The columns which are exported from ISSMI include: 
 
ISSMI field Description 

BlkId Block ID, such as Bud-N1, based on first three letters of the forest name and the compartment ID. 

StockNo Tree stock number 

Y UTM coordinate north (negative values are south of the equator) 

X UTM coordinate east 

Spp Species numeric code 

Spg Species group number 

Code A three-letter species mnemonic 

Diam Tree diameter in cm at dbh or above buttress 

Quality Tree quality, from 1-5 

Status A code indicating selection status. 0 means not selected or a Reserve tree, +1 is a Seed tree, -1 is a Harvest tree 
 

Tree selection 
The tree selection process introduced during the last consultancy has been simplified.  The 
earlier scheme of using various weights to balance the relative importance of tree size, spe-
cies group and quality was 
too opaque and complicated, 
and did not take into account 
spatial relationships among 
trees.  The new scheme is 
simple and can be explained 
by reference to the tree selec-
tion screen, which appears 
under the ISSMI menu Forms 
► Silviculture, and is shown in 
Figure 7. 
 
This form allows a different 
treatment to be applied to 
each compartment.  The speci-
fications for both harvest and 
seed trees are similar.  The number of trees to per ha to be selected is set, together with the 
applicable species group, the lowest acceptable quality standard, and the minimum spacing 

Figure 7  Form for tree selection 
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in metres between selected trees.  For harvest trees, species which have less than a specified 
stocking per km2 can be excluded.  Once these criteria have been given, clicking the Apply 
button will update the Status field in the StockTrees table of the database for that compart-
ment to reflect selections made.   Subsequent reports and maps for that compartment will 
show the selection made. 
 
In logic, trees within the specified species groups and quality band are regarded as of equal 
value, but are sorted by size from largest to smallest, so that larger trees that satisfy the crite-
ria are picked first.  Only species which exceed the specified minimum stocking per km2 are 
included on this list.  Once a candidate tree is picked, the current and adjacent blocks are 
scanned for other trees in the same category that may already have been picked and which 
are closer than the designated minimum distance.  If there are other selections within that 
distance, the tree is not chosen, and another one is tried. 
 
The Status field in the StockTrees can be set to one of three numerical values.  Harvest trees 
are coded –1, seed trees as +1, and reserve trees as 0.  In the quick mapper, these are illus-
trated by the colours blue, red and green respectively.  In the revised version of the Excel 
block mapper, the same colour scheme is also used, as well as the symbols X for harvest tree 
or ST for seed tree. 
 
The analysis of tree spatial arrangements fails if, due to errors in block co-ordinates, two 
blocks are superimposed.  In this case, an error message appears which gives the relative 
block numbers involved.  Co-ordinate errors must therefore be eliminated before the tree 
selection can be completed successfully. 

Revisions to management report 
The report menus have been re-organised and a new report added which summarises spe-
cies numbers and volumes for harvest, and tree numbers for reserve trees, and seed trees.  
This should prove useful as an additional forest management tool.  Appendix A details the 
revised menu structure for ISSMI and lists the various reports available from the menu. 

Installation 
The current version of ISSMI requires the installation files shown in the table overleaf. At 
first installation, these files should be copied into appropriate directories, and the SETUP.EXE 
program run by clicking on it from the Windows Explorer.  This installs Visual Basic 6 re-
source files onto the local workstation WINDOWS\SYSTEM directory as required.  Installation 
also assumes that the system is properly configured with MS Office 97 or MS Office 2000, 
otherwise the Access and Excel files will not work.  
 
ISSMI is started by clicking on the ISMI2-07.MDB file from the Windows Explorer, or by cre-
ating a shortcut to it on the desktop.  The first time this is done after installation, the Data-
base►Open menu selection must be chosen to set up the links to the data file, ISSMI 
DATA.MDB.  This does not need to be repeated unless the data file is renamed or moved to 
another directory. 
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File Installed location and description 

ISMI2-07.MDB The ISSMI Access application.  It can be installed in a suitable directory (the ISSMI directory) on each workstation 
on a network using the database.  When used for the first time after installation,  the Database►Open command 
must be used to set up the database links (see Appendix A). 

ISSMI DATA.MDB The central database, located on a network file server.  The name of this file can be modified as desired, but to 
avoid confusion and loss or duplication of data, there should be only one working copy.  Backup copies should be 
made from time to time on a different disk drive (in case of drive failure).  This file contains only data tables, and 
has no code, queries, reports, or forms that are part of ISSMI. 

ISSMIMAP.EXE The quick mapper application.  This should be copied from the setup directory (see below) into the ISSMI directory 
on the workstation.   

ISSMIMAP.CAB This should be located in a convenient setup directory – which could also be the ISSMI directory, but not n
sarily.  It contains installation files for ISSMIMAP.EXE. 

eces-

SETUP.EXE Located in the setup directory, this is run to install ISSMIMAP.EXE 

SETUP.LST This file is required by the SETUP program, and must be in the setup directory. 

ISSMI-TM.XLS The Excel block mapping program.  This should be located in the ISSMI directory. 
 

Forest management and block selection 
As has been discussed in earlier reports and elsewhere, ISSMI as a forest management sys-
tem is premised around the selection of 4-ha blocks for harvesting or other treatments on a 
15-year cycle that is adaptive to forest growth or other dynamic changes.  Every 15-years, 
compartments will be re-surveyed and their condition re-assessed.  The blocks allocated for 
harvesting in any one 15-year cycle should be those which satisfy certain criteria.  The pre-
cise nature of these criteria will need to be refined with experience, but as a first approxima-
tion, the consultant suggests the following benchmarks: 

� The number of harvestable trees over 50 cm should be  between 5-10 per ha.  This is 
equivalent to around 15-30 m3/ha.  No more than 10 trees per ha over 50 cm should be 
harvested under any circumstances. 

� The number of reserved trees over 50 cm should at least equal to the harvest trees.  In 
other words, no more than 50% of stock trees over 50 cm should be harvested under any 
circumstances. 

� A species should not be harvested if it is locally rare, even though it may be classified in 
an exploitable group.  The consultant suggests that average stockings on a compartment 
should exceed 50 trees/km2 before a species is exploited. 

� The advance growth in the size classes 30-50 cm should be at least double the stock (in-
cluding reserve and seed trees) over 50 cm for exploitable species.  This indicates healthy 
regeneration, and a balanced diameter distribution. 

 
These various points need to be justified in some depth, which time does not permit in this 
context.  It has been agreed with the project management that the consultant should write a 
scientific paper describing the ISSMI system.  This paper would include a justification and 
explanation for the harvesting and protection criteria, and a comparative review of similar 
forest management systems. 
 
ISSMI in its present form does not provide explicit selection of blocks either in map or list 
form, using the above criteria.  An add-on  Excel program that will provide this facility is in 
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preparation, and should be available for field testing within a few weeks.  The ISSMI menu 
has already been configured to allow this, as indicated in Appendix A under Reports►Block 
summary.   
 
ISSMI stock maps and tree selection lists are already being used to control felling on the 
ground.  However, prior to the present assignment, ISSMI did not select trees well, and there 
has been a tendency to fell more heavily than the 5-10 tree/ha guidelines given above.  The 
latest version will give good selections provided the parameters under the Forms► Silvicul-
ture dialog (see Figure 7 and Appendix A) are set to reasonable values.  Of importance here, 
relative to the above criteria, are: 

� Maximum number to fell per ha should not exceed 10. 

� Minimum distance between trees to be harvested should be at least 10 m. 

� Minimum trees/km2 to harvest species should be at least 50. 
 
Respecting these criteria will ensure that harvest trees are well distributed and not clumped 
together, that felling is not excessively heavy, and that locally rare species are not harvested. 
 
When the block selection facility becomes available, this will provide an additional layer of 
control and protection, by indicating through a list and thematic map which blocks should 
be included in a harvesting operation, and which should be left. 
 
ISSMI will certainly evolve as a management system as knowledge improves and the data 
system itself is widely and routinely applied in the forest districts.  However, the basic con-
cepts of strong monitoring and control on the ground, complete transparency in yield selec-
tion and control,  and silvicultural adaptability, permit this evolution whilst encouraging 
better forest management practice. 
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Exploratory inventory 

Objectives 
A clear distinction needs to be made between exploratory inventory (EI) and the manage-
ment inventory incorporated within ISSMI.  The EI is a one-off procedure undertaken when 
a reserve is first being brought under management or, as in the case with many reserves in 
Uganda, when management is being reintroduced after a lapse of many years.  Its intention 
is to provide a basis for compartmentation, and an idea of annual allowable cut and major 
commercial species for the reserve as a whole.  It is not intended or able to provide man-
agement information at or below the compartment level. 
 
ISSMI is a system of continuous forest inventory (CFI), with a 15-year remeasurement cycle, 
and if instituted and established, further use of the EI procedure in a reserve should not be 
necessary. 

Design 
Figure  8  Exploratory inventory design 

 
1 km square grid sampling unit

10 plots per
transect, at 100 m
intervals, starting at
50 m.

2 randomly located
transects per grid
unit

Plots are 500 m2
each, the same
design as for ISSMI

The EI design that the consultant 
has proposed is a partially ran-
domised stratified design.   The 
sample plots use the same design 
as for ISSMI (see Figure 3) and 
have an area of 500 m2.  They are 
laid systematically at 100 m inter-
vals along a randomly located line 
of 1 km length.  Two random lines 
are placed within a stratum, which 
comprises a 1 km2 block. 
 
This design has been adopted so 
that the block lines, which demar-
cate the strata, can be retained as 
the basis for subsequent ISSMI op-
erations. 
 
This design has numerous historical precedents.  H.C. Dawkins, in his 1958 work The Man-
agement of Natural Tropical High-Forest with special reference to Uganda discussed the advan-
tages of a similar design, and it was adopted for several inventories conducted in Belize.  In 
these earlier designs, the random strips were measured as continuous lines, broken into re-
cord units.  The use of circular plots in inventories in the tropics also has many precedents, 
and the combination of both methods combines the advantages of an effective randomisa-
tion method with a compact and rapidly demarcated sample unit.  The compatibility of the 
sample unit with ISSMI is also designed  to reduce costs and re-use skills and software from 
the latter operation.  Personnel experienced in measuring ISSMI plots can rapidly adapt to 
the EI procedure. 
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It should be noted that the block of 1 km2 is a statistical stratum with two random sampling 
units, the transects.  A within-transect variance estimate can be made using systematic sam-
pling formulae applied to the plot data, using methods such as those described in M.S. Phil-
ips’s Measuring Trees and Forests or the FAO Manual of Forest Inventory.  Although it is useful 
if a statistical strata corresponds to a forest type, it is not necessary, and may not always be 
possible where there is no prior information on species distribution. 
 
The design described above provides a sampling intensity of 1% for trees down to 20 cm 
dbh, and of 0.25% for trees from 10-19 cm dbh.  This is a relatively high intensity for explora-
tory inventory, and should provide strong indicative information for preliminary forest re-
serve management planning. 

Software for sample frame genera-
tion Figure 9  Dialog for inventory transect generator 

 

 

An Excel program called inventory lines.xls 
has been written that generates random 
transects in a format that can be incorpo-
rated into an ArcInfo or ArcView map. 
 
When this program is started, the dialog 
shown in Figure 9 appears.  The UTM co-
ordinates for the SW and NE corners of the 
total inventory area should be entered and 
the Generate button clicked. 
 
The output file name will be reported when it is written, and should be noted down.  The 
name will be similar to INVTR1.LIN.  In ArcInfo, the GENERATE, CLEAN and BUILD instruc-
tions can be used to convert this file into a coverage that can be then be incorporated into a 
map in ArcView. 

Field forms 
A field form has been designed that can be used for early training exercises, and is attached 
as Appendix B.  This is similar to the ISSMI inventory plot form, except that location infor-
mation for the inventory block, the transect position, the survey direct (East or West) and the 
plot number need to be entered. 

Data processing software 
No software has yet been written for the EI data entry or analysis.  It is considered that a 
minimum of two weeks is required for this task, and it should clearly be prioritised if the EI 
work is to go forward without delay. 
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Other issues 

Tree volume sampling 
Since the consultant provided training in tree volume sampling in June 1999, little has been 
done on this work, and only about six trees have been measured.  Project staff have made 
some efforts at designing a data in-
put format, but without any great 
success. 

Figure 10  Relascope-based volume equations and form height lines 
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It is evident that the existing tree 
volume equations underestimate 
tree volumes substantially.  The 
various models correspond roughly 
to form heights1 between 5 and 10 
m, whereas for tropical forests gen-
erally, the range that would be ex-
pected would be between 10 and 15 
m or perhaps higher.    Figure 10 
shows the existing relascope-based 
equations overlaid with the form 
height lines for 5, 10 and 15 m. 
 
There is therefore some urgency about developing at least a general equation that can be 
used to estimate volumes more reliably.  It should not be difficult to undertake the field 
measurements proposed in conjunction with ongoing exploitation, and to rapidly measure 
200-300 trees that would be sufficient for a set of preliminary equations.  The consultant is 
concerned however, that because some 18 months have elapsed since the training exercise, 
many of the points made at that time may have been forgotten.    Nonetheless, whatever im-
perfections may exists in the procedure can be corrected later;  it is more important now that 
field work should go ahead as rapidly as possible. 
 
A simple data entry format is being prepared which can be used to enter and check the data.  
The consultant will provide a copy of this as soon as it is completed. 
 
The log volume tables in the Departmental Standing Orders (1997 revision) were also re-
viewed.  These tend to overestimate log volumes calculated directly by Huber’s formula, 
although they are themselves based on the same formula.    This is because they show vol-
umes against  class mid-points, based on linear measure, whereas the volumetric class mid-
point should be at the square root of the class interval.  This problem could be resolved by 
making more detailed tables, with smaller intervals, and using a correctly weighted class 
mid-point to eliminate bias. 
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1 Form height is the ratio of volume to tree basal area.  It is the height of a cylinder with the same volume as the tree bole. 



Permanent sample plots 
The PSP data entry system EPHRU now contains measurements for 10 PSPs.  If possible, 
more data should be entered to avoid too large a backlog developing. 
 
However, in the next phase of the project, PSP data processing issues will need to be ad-
dressed more seriously if the current field work is not to go to waste.  PSP data needs to be 
rigorously and carefully checked if they are to be useful, and some processing programs 
prepared.   Although measurements over periods of less than 3 years do not give good in-
crement estimates, they are useful for testing procedures and methods, and for developing 
software.   All of this will require technical inputs of 3-4 months duration, preferably com-
bined with a training fellowship for a specialist who may take over these duties. 

Data processing management 
Data processing and management in the project still has a somewhat laissez faire and ad hoc 
quality, although record keeping is somewhat improved from the last visit 18 months ago.  
However, the situation is clearly inadequate with regard to the demands of the proposed 
Uganda Forest Authority.   Office space is a very serious constraint, and some of the com-
puters are now verging on obsolescence and will need to be upgraded or replaced within the 
next 12 months.    There is a need for a thorough study of data processing requirements in 
terms of staff, facilities, equipment and space, and training.  This study should review all the 
data processing tasks that the UFA will be expected to undertake on a routine basis, and 
map out a 5-year plan for ensuring adequacy of human resources, training, equipment and 
support in these areas. 
 
The present ad hoc approach means that the ambitious undertakings in terms of ISSMI, ex-
ploratory inventory, PSPs, and GIS services are being channelled into a unit which is inade-
quate in almost every respect to support these services.  Unless this situation is addressed 
with a fair degree of urgency, much of the field work being undertaken at great expense and 
effort will prove to be wasted. 
 
In the short run, thought needs to be given to making the best use of existing resources.  
Space needs to be organised to remove bulky, broken or unused furniture to storage.  The 
foyer of the herbarium can be cleaned out and used for shelving to store data records.  This 
will create more space in the two rooms used for data work.  These rooms, and the equip-
ment, need to be cleaned thoroughly and routinely.   
 
There is a need for more proactive, skilful and positive management of the TSS unit.   At the 
moment, there is little clarity about any sense of schedules and tasks on a weekly or monthly 
basis, or any tracking of data input, checking and output reports.  The consultant considers 
that this should be discussed in the project and the TSS required to produce a weekly list of 
data entered, and reports produced or tasks completed in summary format.  This will help 
to focus effort on organisational matters and avoid waste of the admittedly inadequate re-
sources.  It will also provide statistical information on data processing activities that will 
help in longer term planning. 
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Conclusions 

ISSMI software improvements 
During this visit, the ISSMI data processing system has been considerably strengthened and 
improved in a number of respects.  All the linkages to the ArcView GIS system have been 
fully programmed and tested.  ISSMI can now output compartment tree attribute tables that 
include UTM geo-referencing of each tree, with tree diameter, species code, species mne-
monic, stem quality and selection status.  These can be used to produce high quality com-
partment or polyblock maps with various symbols and colouring schemes based on this at-
tribute data. 
 
The ISSMI quick mapping program has been re-configured to avoid earlier installation prob-
lems.  This will make ISSMI more portable, and will assist the task of decentralising its use 
and providing copies to forestry teaching institutions.  The Excel block mapping program 
has been revised to use standard species mnemonics, a standard colouring and symbol 
scheme for selected trees, and for more convenient operation. 
 
The main ISSMI package has also been reconfigured for optimum operation by splitting the 
data tables from the program and related forms, reports, and queries.  This allows for more 
efficient network operation and for easier upgrading of the ISSMI program.  Network access 
has been tested, and multiple data entry operators can add or edit data on a single master 
file without difficulty. 
 
The tree selection method has been re-designed and re-programmed for greater transpar-
ency and for spatial sensitivity to avoid clumps of harvestable or seed trees.  Selection now 
treats all trees within a designated set of groups and quality grades as equal, but picks the 
largest trees first, and considers a spatial constraint to avoid picking neighbours within a 
designated distance.  Tree selections are now reflected in the Excel block mapping program, 
as well as other output tables and reports.  The former term Residuals for trees not selected as 
either harvestable or seed trees has been changed in all reports, maps and in this report to 
Reserved trees. 
 
In the consultant’s view, the only remaining improvement required for the ISSMI software 
to be complete will be the thematic mapping program for block selection.  He is committed 
to providing this without further consultancy costs, as the programming involved is rela-
tively simple. 

Training in ISSMI 
This visit has seen a major workshop on ISSMI, which took place in Masindi from 6-7 De-
cember.  The consultant provided two key sessions in this workshop and led a field training 
exercise undertaken in compartment W37 of Budongo FR.  This  workshop has formally es-
tablished ISSMI as a standard stock mapping and inventory technique, replacing earlier 
methods used by the Forestry Department. 
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In the office, extensive training has been given to two professional staff on all aspects of 
ISSMI, including geo-referencing, error checking of block co-ordinates, amending species list 
and species group data, GIS outputs and linkages, and tree selection. 

Exploratory inventory 
Data forms and a program to select random sampling transects for the exploratory inventory 
(EI) have been prepared, but much more needs to be done.  In the consultants view, it will 
require a minimum of two weeks dedicated time to prepare EI software for data entry and 
report generation.  Further time should be added on top of that  for training in EI analysis.  
The consultant has suggested that the Kilembe Sawmill Project, presently postponed due to 
security concerns, should be re-thought and re-designed to provide a basis for this to be 
done.  This does require some adjustment of the consultant’s TORs in that project as cur-
rently agreed. 

Permanent Sample Plots 
Some use has been made of PSP software EPHRU provided by the consultant on an earlier 
visit, and data for ten plots are in the system.  However, data entry is lagging well behind 
field work.  As the consultant has said earlier, it will not be possible to manage this task at 
the data processing level unless there are two dedicated personnel assigned to it:  A profes-
sional officer, and a data entry assistant.  The professional officer should be responsible for 
managing, following up and checking all aspects of the PSP work, and should, if efficient in 
their duties, be assigned overseas training opportunities on relevant short courses.  In addi-
tion, further consultancy work is required in at least three phases, to cover immediate data 
processing upgrades and training, a field training and data entry design phases relative to 
PSP re-measurement, and a final and longer consultancy associated with PSP data analysis 
software. 

Tree volume sampling 
In  June 1999 the consultant spent several days providing field training in tree volume sam-
pling.  In the ensuing 18 months, only some 6 trees appear to have been measured, and the 
work appears to have lapsed.  It remains on the critical path, as existing volume equations 
derived from earlier Relascope studies are clearly too low, perhaps by a factor of 30-50%.  
The project should now give a high priority to this issue, and try to measure at least 200 
trees over the next two months, and maintain this momentum continuously over a further 18 
months. 

Conclusion 
At the moment, developments in forest biometry under the EC project have been persued in 
an ad hoc and adaptive fashion.   This has lead to many useful results, such as the ISSMI 
method and software, but is also inefficient, as short-term consultancy has a high overhead 
of travel and report writing, and it is difficult to achieve many kinds of software preparation 
and training in very short periods.   It is to be hoped that in preparing the next phase of EC 
support for forestry, that this type of work is being planned on a more coherent and long 
term basis, linked with an appropriate strategy for human resources development in this 
field. 
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Appendix A:  ISSMI Quick Reference Card 

ISSMI Menus and usage 
Menu Description and usage 
Database► Open Brings up an open database dialog box.  ISSMI will ‘remember’ the last database 

used, so this option is required only when the configuration of the system changes, 
eg if the data file is moved to a new directory, or ISSMI is installed on a new machine. 

 Exit Closes ISSMI.  The same effect is achieved by closing the ISSMI dialog box. 
Edit► Undo Reverses the last operation if possible. 
 Copy Copies a selection to the clipboard. 
 Cut Copies a selection to the clipboard and deletes it. 
 Paste Pastes the clipboard at the current position, replacing a selection if made. 
 Delete Record Deletes the current record. 
 Find Finds text in a table or form. 
 Find Next Finds next instance of the same text. 
 Replace Finds and replaces text in a table or form 
Forms► Stock Survey Opens list of blocks to select one for editing.  The Tools>Form View will display the 

selected block as a data entry form for stock tree data. 
 Inventory Plot Opens inventory plot form for data entry and editing. 
 GeoReference Form to allow UTM coordinates to be entered for a specified block, and then applied 

to the whole compartment via the Apply button. 
 Silviculture Form to set the tree selection criteria for harvesting and seed trees, and apply them 

to a specified compartment. 
 Species groups Form to set species group names, minimum diameter limits, and colours for the quick 

mapping module. 
 Species List Displays the species list, and allows new entries, editing of names, species group or 

volume equation to be applied. 
Mapping► Quick Map Starts the quick mapping module.  This is used to review block and plot co-ordinates 

and progress, and to check on species distribution or tree selection. 
Reports► 

 Block Map Starts the Excel block mapping application.  Draws detailed maps of single blocks 
with lists of trees by harvesting category, for harvesting control and monitoring. 

 Species sum-
mary 

Produces a report for a selected compartment of species tree numbers by harvest, 
seed tree and reserve categories, with harvest volumes.  It also gives a stand table 
by 20-cm classes to assess recruitment and sustainability. 

Group sum-
mary 

Summarises harvest, seed and reserve tree numbers and volumes by species 
groups. 

 

Selected 
yield► 

Tree List Lists for each block the harvest, reserve and seed trees with individual stock num-
bers, for monitoring and control. 

 Stand Tables A general stand table for a compartment, with user-definable size classes,  summari-
sation of tree numbers, basal area or volume, and cumulative or class values, per ha 
or for the whole area. 

 Block Summary This function is not yet working.  It is designed to call the Block thematic mapper. 
Data check► Block Lists the stock tree data for a given block, with all details, in a format similar to the 

field data sheet, for checking purposes. 
 

 Plot Lists the data for an inventory plot, with all details, in a format similar to the field data 
sheet, for checking purposes. 

 Work summary Summarises numbers of blocks, plots and trees in the database by compartment. 
 GIS output files Generates ArcInfo-compatible files of block outlines, and a data table of tree attrib-

utes for a compartment including geo-referenced locations which can be imported by 
ArcView. 
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(Continued/…) 
Menu Description and usage 
Tools► Datasheet view Toggles the current form into datasheet view, if allowed. 
 Form view Restores normal form view for a datasheet. 
 Sort ascending Sorts the datasheet on the selected columns in ascending order. 
 Sort descending Sorts the datasheet on the selected columns in descending order. 
 Print Prints the current form or datasheet. 
 Print preview Previews the printed format of the current form or datasheet. 
 Page setup Sets printer information such as paper size, margins, orientation, etc. 
 ISSMI design Opens the Access database window for ISSMI and restores the standard menu. 
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Appendix B :  Exploratory inventory plot form 
 
Exploratory inventory sample 
plot enumeration form 

OIC enumeration team Date sheet of 

Forest Cpt. Inv. Block UTM East Inv. Block UTM North Transect N  Direction 
 

Plot 

Site codes Observations 

(1) (2) (2) (3) (4) (5) 
Tree No. Species Spp 

Code 
Diam Quality Coded notes 

      
      
      
      
      
      
      
      
      
      
      
      
      
      
      
      
      
      
      
      
      
      
      
      
      
      
      
      
      
      
      
      

Form Revision: 30-Nov-00 
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